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Important

® The following functions are for reference only. Some series products may not
support all the functions listed below.

® Usually we recommend IE 7 or higher version. For those versions below IE 7, it
may not support the operation of some functions.



1 Network Connection

1.1 Preparation

This series speed dome product supports the Web access and management via PC.

Web includes several modules: monitor channel preview, PTZ control, system configuration, alarm and

etc.

Please follow the steps listed below for network connection.

® Make sure the speed dome has connected to the network properly.

® Speed dome IP address and PC IP address shall be in the same network segment. If there is router,
please set the corresponding gateway and subnet mask.

® Use order ping *x* *x** **x x4 (* sneed dome address) to check connection is OK or not.

1.2 Login

Open IE and input speed dome address in the address bar.
For example, if your device IP is 192.168.1.108, then please input http:// 192.168.1.108 in IE address
bar. See Figure 1-1.
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Figure 1-1
The login interface is shown as below. See Figure 1-2.
Please input your user name and password.
Default factory name is admin and password is admin.
Note: For security reasons, please modify your password after you first login.
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Figure 1-2

For WIN 7 and higher version of operating system, it is advised to operate as an
administrator if it is your first time to log in.

1.3 Live Interface

After you logged in, you can see the live monitor window. Now you can operate the speed dome via the
WEB. See Figure 1-3.
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There are six sections:

Section 5: PTZ control
Section 6: PTZ function

1.4 Encode Setup

The encode setup interface is shown as in Figure 1-4.

Sub Stream Protocol

Figure 1-3

Section 1: Encode setup bar
Section 2: Window adjust bar
Section 3: System menu bar
Section 4: Window function option bar

Figure 1-4
Please refer to the following sheet for detailed information.
Parameter Function
Main stream In normal network width environment, main stream can record

video file and realize network monitor.

Sub (Extra)
stream

If network width is not sufficient, you can use sub stream to
realize network monitor. It is to reduce network bandwidth
usage.

Protocol

You can select video monitor protocol from the dropdown list.
There are three options: TCP/UDP/Multicast.

1.5 Video Window Setup

The interface is shown as in

Figure 1-5.
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Figure 1-5
Please refer to the following sheet for detailed information.
SN Parameter Function
1 Image Click it to open picture setup interface. See Figure 1-6. This
control interface is on the top right pane.
2 Original Click this button to go to original size. It is to display the actual
size size of the video. It depends on the resolution of the video.




3 Full screen | Click it to go to full-screen mode. Double click the mouse or
click the Esc button to exit the full screen.
4 Width and Click it to restore original ratio or suitable window.
height ratio
5 Open/close | Left click it to display or hide the PTZ control interface.
PTZ
interface

The picture setup interface is shown as in Figure 1-6.

Image Adjustment

Figure 1-6
Please refer to the following sheet for detailed information.
Parameter Function
Video | pg% Brightness setup icon. It is to adjust | Note:
setup monitor video brightness. ® All the operations here
Contrast setup icon. It is to adjust zﬁﬁjy to WEB end

monitor video contrastness. ® Please go to Setup-

>Camera->Conditions
to adjust brightness,
contrast, hue and

H Hue setup icon. It is to adjust saturation setup.
monitor video hue.

a Saturation setup icon. It is to adjust
monitor video saturation.

Reset | Restore brightness, contrastness
saturation and hue to system default
setup.

--- Original size button. It is to display video actual size. It depends on the video resolution.

e =M~ Full-screen button. Double click or click Esc button to exit full-screen mode.



. Width and height rate. Adjust to original size or suitable for the window.

. Fluency setup. It has three modes: real-time/general/fluency.

. ———Open/close PTZ interface. Left click mouse to display or hide PTZ control interface.

1.6 System Menu

System menu is shown as in Figure 1-7.

Please refer to chapter 1.3 Live, chapter 2 Playback, Chapter 3 Setup, chapter 4 Alarm, chapter 5 Log

out for detailed information.

Figure 1-7

1.7 Video Window Function Option

The interface is shown as below. See Figure 1-8.
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Figure 1-8
Please refer to the following sheet for detailed information.
SN Parameter Function
1 Remark Click it and then select pen color, you can write down the
mark information on the preview interface.
2 Alarm Click it to generate an alarm output and the button becomes
output 1/ red. Click it again to stop alarm output.
Alarm There is only one alarm output icon since this series product
output 2 supports one relay output.
Please note the alarm output interface may vary due to
different series products.
3 Digital When video is in original status, click this button you can
zo0m select any zone to zoom in. After zoom in ,you can drag the
zoom in area in the specified area. Right click mouse system
restores original status. You can use the wheel to zoom out
the video.




4 Snapshot You can snapshoot important video.
You can go to Setup->Camera->Video->Path to modify the
local record save path.
5 Triple snap Click it, system can snap at 1f/s for three times. All images
are memorized in system storage folder.
6 Record When you click local record button, the system begins
recording.
You can go to Setup->Camera->Video->Path to modify the
local record save path.
7 Audio Turn on or off audio when you are monitoring.
output You can go to Setup->Camera->Audio to set.
8 Bidirectional | Click it to begin audio talk. You can go to Setup->Camera-
talk >Audio to set bidirectional talk mode.
9 Help Click it to open help file.

1.8 PTZ Control

Before PTZ operation, please make sure you have properly set PTZ protocol. (Please go to Setup-

>System->PTZ to set.).

Here you can view direction keys, speed, zoom, focus, iris button. See Figure 1-9.

® PTZ direction: PTZ supports eight directions: left/right/up/down/upper left/upper right/bottom

left/bottom right/ fast positioning.
® Speed: The step 8 speed is faster than step 1.
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Figure 1-9




1.9 PTZ Setup

The PTZ setup interface is shown as in Figure 1-10.

PTZ Function

P> Start

Figure 1-10

Click PTZ set button, the interface is shown as in Figure 1-11.Here you can select scan, preset, tour
pattern, assistant function and etc.

PTZ Function

| Scan v

Figure 1-11

Please refer to the following sheet for PTZ setup information.



Parameter | Function

Scan ® Select Scan from the dropdown list, click Start button, you can
begin scan operation. Default SN is 1.

Preset ® Input the preset value and then click View button, the camera
turns to the corresponding position of the preset.

Tour ® Select Tour from the dropdown list and then click Start button,
you can begin tour.

Pattern ® You can select Pattern from the dropdown list and then click
Start button to begin PTZ movement.

Assistant ® Reserved assistant function.

Goto ® |tis the accurate positioning function. Please input
corresponding horizontal angle, tilt angle, and speed dome
zoom speed and then click Goto button to go to a specified
position.

® One unit of the horizontal angle or tile angle stands for 0.1
degree.

Pan Select Pan from the dropdown list and then click Start button, you

can turn the PTZ realize 360 degrees movement. Click Stop button
to stop current operation.

For detailed setup information, please go to Setup->PTZ-Function.

-I- Start
Click - button to begin a PTZ operation. Now you can see it becomes Stop button. Click it

again to stop current PTZ operation.



2 Playback

2.1 Playback Interface

The playback interface is shown as in Figure 2-1.
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Figure 2-1
You can refer to the following sheet for detailed information.
SN Name
1 Playback control button
2 Date
3 File list
4 Time process format

2.2 Playback Control Button

Playback control button is shown as below. See Figure 2-2.
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Figure 2-2
You can refer to the following sheet for detailed information.

SN Name Function

1 Play To start or resume playback.

2 Stop Stop current playback.

3 Frame by frame Play next frame.
Please pause playback first if you want to use
frame by frame playback function.

4 Slow play Slow playback.

5 Fast play Fast playback.

6 Mute Click it to mute. Click it again to restore audio
function.

7 Volume Set record volume level.

Date

2.3

The
o
o

colors here have different meanings.
Green: Current selected data.
Yellow: Current date has record file.

® Blue: Current data has record file and it has been selected.
You can check the corresponding file record here to view the file record you are interested.

24

Click =

File List

playback, at the same time, you can view file size, file start time and file end time.

The different colors here has different meansings.

Green: Normal record.
Yellow: Motion detect record.
Red: Alarm record.

Blue: Manual record.

, you can go to file list interface. See Figure 2-3. Double click a record file to begin

10
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Figure 2-3
You can refer to the following sheet for detailed information.
Icon Name Function

Q& Search It is to search record from the start time of you

selected date to the previous 24 hours.
—u Stop Click it to download selected file(s) to local

PC.

= Back Click it to go back to calendar interface to
select date again.

11



2.5 Process bar format

You can refer to the following sheet for detailed information.

Icon

Function

& 24hr

Process bar is in 24H mode.

[+

® zZhr

It is to display the record files of previous two
hours.

It is to display the record files of previous one
hour.

®30min

IE

It is to display the record files of previous 30
minutes.

12



3 Setup

3.1 Camera

3.1.1 Conditions
Here you can set camera property. Adjust video parameter to get best preview effect. See Figure 3-1.

IP PTZ Dome

Camera Conditions

Profile Management

R V'.:.m“ - Profile | Normal =]
> Audio m WB Mode | Auto [~]
Network Exposure
P1Z NR
Peripheral Day&Night
Event Focus
Storage Zoom
System Sharpness
Information Picture
Defog
Default
Figure 3-1
Please refer to the following sheet for detailed information.
Parameter Function
Config File Here you can set camera setup mode. It includes:
normal/day/night.
White Balance It is to set camera white balance. It includes:

auto/manual/ATW/outdoor/indoor/outdoor auto/sodium light
auto/sodium light.

Exposure It is to set camera exposure mode. It includes:

auto/manual/aperture has the priority/shutter has the priority.
NR It is to set camera denoise mode. It: is 2D/3D noise reduction.
Day/Night It is to set camera day/nigh switch mode.

The type includes: electronic/mechanical.
It includes four modes: auto/B&W/Color/Photosensor.

Focus It is to set camera focus mode. It includes: auto/manual/semi
auto.

13



Zoom It is to set digital zoom/camera zoom rate. You need to check
the box here to enable digital zoom function.

Sharpness It is to set camera lens sharpness, and sharpness control level.

Picture It is to set camera video. It includes:
style/hue/brightness/saturation/ chroma control/gamma/picture
flip/picture freeze.

Defog It is to set camera defog mode, including off and auto.

Default It is to restore factory default setup.

Important

Please make sure your purchased camera supports all the functions listed here.

3.1.1.1 White Balance
White balance interface is shown as below. See Figure 3-2.

IP PTZ Dome

Camera Conditions

Profile Management

Profile | Normal [~]
m WB Mode | Auto [~]
» Exposure
» NR
Peripheral » Day&Night
Event » Focus
Storage » Zoom
System » Sharpness
Information » Picture
» Defog
» Default
Figure 3-2
Please refer to the following sheet for detailed information.
Parameter Function
WB mode ® [tis to set camera white balance. It includes:

auto/manual/ATW/outdoor/indoor/outdoor auto/sodium
light auto/sodium light.

® [For manual mode, you can input red gain and blue gain
value.

3.1.1.2 Exposure

14



Exposure interface is shown as below. See Figure 3-3.

IP PTZ Dome

Camera Conditions Profile Management

z Profile ' Normal
> Video E

> Audio Exposure | Auto [~]

Network
P1Z
Peripheral

Anti-fiicker @ Qutdoor ©) 50HZ ©) 60HZ

» NR
» Day&Night

Exposure Comp [—| ¢ [+]8
Slow Exposure [—] L [#]1

Max Auto Gain O Low ©) Middle © High

Event » Focus

AE Recovery | 15m

Storage » Zoom
System » Sharpness Slow Shutter [v]
Information » Picture Auto SS Limit | 1/30
» Defog
»

Default
WDR | Close

HLC | Close

MEE EE

BLC Close

Figure 3-3

Please refer to the following sheet for detailed information.

Parameter Function

® |tisto set camera exposure mode. It includes:
auto/manual/aperture has the priority/shutter has the
priority. The default setup is auto.

® [or the auto exposure mode, the gain, shutter and iris are
in auto mode.

® For manual exposure mode, the gain, shutter and aperture
is in manual mode.

® \When the aperture has the higher priority, the aperture is
in the manual mode and the gain and shutter is in auto
mode.

® \When the shutter has the priority, the shutter is in manual
mode, gain and aperture is in auto mode.

Exposure mode

Anti-flicker It is to set the camera anti-flicker mode, including outdoor,
50HZ and 60HZ.

Exposure It can adjust video whole brightness via setting exposure object

compensation brightness so that it can suit for different environments.

Gain level It is to set video brightness under the low illumination
environments.

Shutter It is to set camera exposure time.

Iris It is to set camera iris.

15



Slow exposure If the light may change greatly, you can use slow exposure to
get image so that the camera can get stable video.

Max Auto gain It is to set camera max gain.

Slow shutter In lower illumination environment, you can lower the cameras
auto exposure time to capture the image and enhance the
definition. For the moving object , the trail may appear. Please
note it is valid in auto mode.

Auto Slow It is to set camera min shutter value.

Shutter Min

value

AE resume Manually adjust Iris + or Iris -, system can auto resume
previous exposure mode.

WDR Mode For the environments of strong contrast effect, it can auto
adjust image contrast so that you can see the dark and bright
section at the same time.

The BLC and HLC function can not be valid at the same
time. Once one function is valid, the other one is null
automatically.

HLC When there is strong light source in the environment, system
can auto adjust video brightness to remove the overexposure
effect.

BLC For the environments of strong contrast effect, such as under
the backlight environment, system can auto adjust image
contrast to get clear object.

Note:

The device doesn’t support WDR mode, HLC and BLC at the same time.

3.1.1.3 NR (Noise Reduction)
The noise reduction interface is shown as in Figure 3-4.

16



IP PTZ Dome

Camera Conditions

Profile Management

T Profile | Normal =]
> Audio » WB 2DNR [¥]
Network » Exposure Grade |—|. 0 |+/8
PTZ m 3DNR [@
Peripheral » Day&Night Grade [=] 0 e
Event » Focus
Storage » Zoom
System » Sharpness
Information » Picture
» Defog
» Default
Figure 3-4
Please refer to the following sheet for detailed information.
Parameter Function
2D NR It is to control noise. The higher the level is; the small the noise

is. Comparing with the previous one, the picture may become a
little bit blurry.

3D NR It is to control noise. The higher the level is; the small the noise
is. Comparing with the previous one, there may appear some
smear phenomenon.

3.1.1.4 Day & Night

Important

Please make sure your purchased product camera supports this function.
The day/night mode is shown as in Figure 3-5.

17



IP PTZ Dome

> Video

> Audio
Network
PTZ
Peripheral
Event
Storage
System

Information

Camera Conditions

Profile Management

Profile ' Normal [~]
» WB Type © Electronic @ Mechanical
B Day&Night | Photoresistor [~

» NR

» Focus

» Zoom

» Sharpness
» Picture

» Defog

» Default

Figure 3-5
Please refer to the following sheet for detailed information.
Parameter Function
Day & night Itis to set camera day/nigh_t mode. _
The type includes: electronic/mechanical.
The mode includes: B&W/color/auto/photosensor.
Sensitivity It is to camera day & night switch sensitivity.
3.1.1.5 Focus

The focus interface is shown as in Figure 3-6.

18



IP PTZ Dome

Camera Conditions

PTZ
Peripheral
Event
Storage
System

Information

Profile Management

Profile  Normal

Exposure Focus Limit | Auto
NR

Day&Night

]
WB Focus Mode | Semi Auto [~]
[]
[=]

Sensitivity | Default

IR Correction ) Enable ) Disable @ Auto

Zoom
Sharpness
Picture
Defog
Default

Figure 3-6
Please refer to the following sheet for detailed information.

Parameter Function

Focus mode It is to set camera focus mode. It includes: auto/manual/semi
auto.

Focus limit It is to camera focus distance in case the focus distance is too
small and the focus goes to the enclosure. At the same time,
you can change focus distance to adjust focus speed.

Sensitivity It is to set camera focus sensitivity. The higher the value is, the
easier it is to activate focus. The lower the value is, the difficult
it is to activate focus.

IR Correction Itis to set IR light focus cqrrection function to enhance focus
effect and remove the IR light effect on the focus.

3.1.1.6 Zoom

Zoom interface is shown as in Figure 3-7.

19



IP PTZ Dome

Camera Conditions

> Video

> Audio
Network
PTZ
Peripheral
Event
Storage
System

Information

Profile Management

Profile ' Normal [~]
» WB Digital Zoom [
» Exposure Zoom Speed || BIESL:

» NR
» Day&Night

» Focus

» Sharpness
» Picture

» Defog
» Default

Figure 3-7
Please refer to the following sheet for detailed information.
Parameter Function
Zoom speed Itis to set camera zoom speed. The bigger the value is, the
faster the speed is.
Digital zoom Check the box here to enable digital zoom function.

3.1.1.7 Sharpness

Sharpness interface is shown as in Figure 3-8.

20



IP PTZ Dome

Camera Conditions

Profile Management

)\';];eo Profile ' Normal [~]
> Audio » WB Sharpness =] - O [#]9
Network » Exposure Sharpness CNT | = | e} |#]5
PTZ » NR
Peripheral » Day&Night
Event » Focus
Storage » Zoom
System > Sharpness |
Information » Picture
» Defog
IPETZEem S » Default
Figure 3-8
Please refer to the following sheet for detailed information.
Parameter Function
Sharpness It is to set camera sharpness. The higher the sharpness is, the
clear the image is. The object edge becomes clear too.
Sharpness It is to set camera control level. The higher the value is, the
control level strong the control level is.

3.1.1.8 Picture
Picture interface is shown as in Figure 3-9.
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IP PTZ Dome

Camera Conditions Profile Management

>V~:I Profile | Normal E
> Audio » WB Style  Standard (=]
Network » Exposure Hue |=| L |50
P1Z A Brightness [—| ( [+]50
Reriptieral 2EDayRbopE Saturation [—] L E’5O
Event » Focus : =
Storage s Chroma CNT [=] 0 &2
System » Sharpness Gamma [—](} [#]1
Information m Picture Flip []
» Defog
» Default
Figure 3-9
Please refer to the following sheet for detailed information.
Parameter Function
Style It is to set video style. It includes: Standard/soft/ flamboyant.
Hue It is to set picture hue.
Saturation It is to set color purity. The higher the purity is, the more color

the video is. The lower the purity is, the dark the video is.
It is to set video color control level. The higher the value is, the
higher the control level is.

Chroma control

Gamma It is to set image gamma value.
Brightness Itis to set'video brightness. The higher is value is, the bright
the video is.
Picture Flip It is to set video display mode. It is to turn camera.
3.1.1.9 Defog

22



IP PTZ Dome

Camera Conditions

Profile Management

— Profile | Normal

> Video

> Audio » WB Mode | Off
Network » Exposure

PTZ » NR

Peripheral » Day&Night

Event » Focus

Storage » Zoom

System » Sharpness

Information » Picture

IPPTZ Dome » Default
Figure 3-10

Parameter | Function

Mode It is to set the camera defog mode, including off and auto.
Intensity It is to set defog intensity, able to select only when the defog mode is auto.

3.1.1.10 Default

Default interface is shown as in Figure 3-11.

IP PTZ Dome

| condions |
> Video £
> Audio
Network
PTZ
Peripheral
Event
Storage
System

Information

IPPTZ Nome

Camera Conditions

Profile Management

Profile | Normal

» WB O

» Exposure FIws ("] Exposure
* NR CINR [*] Day&Night
» Day&Night [T Focus [ Zoom

» Focus [“ISharpness [ Picture

» Zoom [C] Defog

> P!

» Picture Dofaui

» Defog
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Figure 3-11

Please refer to the following sheet for detailed information.

Parameter Function

Default It is to restore camera parameter to factory default setup.

3.1.1.11 Profile Management
Profile management interface is shown as in Figure 3-12.

Ll [uve [ papsck | sewp | mam_ | togou ]

Camera Conditions Profile Management @

= Profile Management  © Normal ¢ Full Time ¢ Schedule
Vid

> Audio Default I | Refresh | l Save

Network
Ptz
Peripheral
Event
Storage
System

Information

Figure 3-12
Please refer to the following sheet for detailed information.
Parameter Function
Profile There are three modes: normal/full-time/schedule. The default
Management setup is normal.
Normal It is to adopt the general parameter on the profile file.
Full-time It is to adopt day or night general parameter on the profile file
all the time.
Schedule It is to adopt the day or night parameter on the profile file by
time you set here.
3.1.2 Video

3.1.2.1 Video bit stream
The video bit stream interface is shown as below. See Figure 3-13.
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IP PTZ Dome

Camera Video

Snapshot

> Conditions
Main Stream Sub Stream

I Enable
L= Cods-Stream Type General [=] Code-Stream Type General [=]
PTZ

Encode Mode H.264H [=] Encode Mode H.264 [=]
Peripheral .

3 Resolution 1080P (1920°1080)  [+] Resolution CIF (352*240) [=]

Event

Frame Rate(FPS) 30 E Frame Rate(FPS) 15 |Z|
Storage .
¢ Bit Rate Type CBR E Bit Rate Type CBR E

ystem

Reference Bit Rate 1280-3192KbiS Reference Bit Rate 28-512Kb/S
Information

Bit Rate 4096 [=] Bit Rate 192 [=]

| Frame Interval 60 (30~150) | Frame: Interval 30 (15~150)

Watermark Settings
Watermark Character | DigitalCCTV
Defeut || Reflesn ||  sae
Figure 3-13

Please refer to the following sheet for detailed information.

Parameter Function

Main Bit stream type It includes general stream, motion stream and alarm
stream stream. You can select different encode frame rates for
different recorded events.

The frame rates of the motion detect and alarm is
customized.

There are four options: H.264, H.264H, and MJPEG
encode mode.

® H.264 : Main Profile encode mode.

® H.264H: High Profile encode mode.

® MJIPEG: In this encode mode, the video needs
general large bit stream to guarantee the video
definition. You can use the max bit stream value in
the recommend bit to get the better video output
effect.

Encode mode

Resolution There are multiple resolutions. You can select from the
dropdown list.

For each resolution, the recommended bit stream value
is different.

Frame Rate PAL: 1~25f/ls, NTSC: 1~30f/s..
(FPS)

The frame rate may vary due to different resolutions.

25



Parameter

Function

Bit Rate Type

There are two options: VBR and CBR.

Please note, you can set video quality in VBR mode.
In MJPEG mode, the bit stream control mode can only
be CBR.

Recommended
Bit

Recommended bit rate value according to the resolution
and frame rate you have set.

Bit Rate

® In CBR, the bit rate here is the average value.
usually it is within a range of +10%. In dynamic
video, system needs to lower frame rate or video
quality to guarantee the value.

® In VBR mode, the bit rate here is the max value. It
can be lower than the setup value when the scene
is simple.

| Frame
interval

Here you can set the P frame amount between two |
frames. The value ranges from 1 to 150. Default value
is 60.

Recommended value is frame rate *2.
Important

| frame interval setup is null if it is the MIJPEG
encode mode.

Watermark

This function allows you to verify the video is tampered
or not.

The max length is 128-digit. The character can only
include number, character, underline and hyphen.

Sub
stream

Enable

Please check the box here to enable extra stream
function.
This function is enabled by default.

Bit stream type

General bit stream.

Encode mode

There are four options: H.264, H.264H, and MJPEG
encode mode.

® H.264 : Main Profile encode mode.
® H.264H: High Profile encode mode.

® MJPEG: In this encode mode, the video needs
general large bit stream to guarantee the video
definition. You can use the max bit stream value in
the recommend bit to get the better video output
effect.

Resolution

There are multiple resolutions. You can select from the
dropdown list.

For each resolution, the recommended bit stream value
is different.
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Parameter Function

Frame Rate PAL: 1~25f/ls, NTSC: 1~30f/s..

(FPS) The frame rate may vary due to different resolutions.

There are two options: VBR and CBR.

Bit Rate Type . o
Please note, you can set video quality in VBR mode.

Recommended | Recommended bit rate value according to the resolution
Bit and frame rate you have set.

Bit Rate ® In CBR, the bit rate here is the average value.
usually it is within a range of ==10%. In dynamic
video, system needs to lower frame rate or video
quality to guarantee the value.

® In VBR mode, the bit rate here is the max value. It
can be lower than the setup value when the scene

is simple.
| Frame Here you can set the P frame amount between two |
interval frames. The value ranges from 1 to 150. Default value
is 60.
Recommended value is frame rate *2.
Important

| frame interval setup is null if it is the MIJPEG
encode mode.

3.1.2.2 Snapshot
The snapshot interface is shown as in Figure 3-14.

IP PTZ Dome ST TR S T T

Camera Video Snapshot Overlay @

> Conditions
m Snapshot Type General >
deo

Image Size
> Audio

Network
Ptz

Quality

Interval

Peripheral Default Refresh I I Save
Event

Storage

System

Information

Figure 3-14

Please refer to the following sheet for detailed information.
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Parameter Function

There are two modes: general (schedule) and Event

(activation).

General (schedule) snapshot is to snap in the specified period.

Event (Activation) snapshot Is to snap when the motion detect,

camera masking, local alarm event occurrence.

If you want to use this function, please make sure:

® The event occurred during the specified period.

® Motion detect, video masking, local alarm and
corresponding snap function are all enable.

Snapshot type

Image size It has relationship with the resolution of the main stream.

Quality It is to set the image quality. There are six levels.

Interval

It is to set snapshot frequency. The value ranges from 1s to 7s.

3.1.2.3 Video Overlay
The video overlay interface is shown as in Figure 3-15.

IP PTZ Dome v [ Playoack | sews | Aam | Logow

Camera Snapshot

> Conditions

> Audio

4 - o
» Channel Title 22 Draw iﬁ Delete

» Time Title

N Ii Clear ‘— Goto

Network
PTZ
Peripheral
Event
Storage
System

Information

®

Figure 3-15
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IP PTZ Dome

Camera Snapshot

> Conditions
» Privacy Mask @ Enable ) Disable
sl Input channel title:

» Time Title IP PTZ Dome
» 0SD

Peripheral
Event
Storage
System

Information

Default H Refresh | | Save

Figure 3-16

IP PTZ Dome | tve | Paybsck | sewp [ Aam [ Logou |

Camera Snapshot @
> Conditions %3

» Privacy Mask @ Enable () Disable
» Channel Title [V]Week Display

» OSD

> Audio
Network
P1Z
Peripheral
Event
Storage
System

Information

Figure 3-17
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IP PTZ Dome

Camera i Snapshot

> Conditions 2014 505
EUE A |, Privacy Mask  Preset: 9 Enable ) Disable
u:.
» Channel Title -
> Audio Temperature: _) Enable © Disable
» Time Title
Network m Coordinates: ~) Enable © Disable
PTZ
Zoom: _) Enable @ Disable
Peripheral
o : O
o Location: -/ Enable '@ Disable
Storage Input location:
System
Information
Default | l Refresh | l Save
Text Align
Right [=]
Figure 3-18

Please refer to the following sheet for detailed information.

Parameter | Function

® Select a “privacy mask SN”, click “Draw”, and then you can draw the privacy mask
zone which is corresponding to the privacy mask SN in the video monitoring window.

¢ Click “Delete” to delete the privacy mask zone which is corresponding to the privacy

Privacy mask SN.
mask : . .
® Click “Clear” to clear all the privacy mask zones which are drawn by users.

¢ Click “Go to” to check the privacy mask zone which is corresponding to the privacy

mask SN.
® Check “Enable” to display channel title in the video monitoring window; check
Cf_}rei?nel “Disable” and it will not display.
itle

® You can use the mouse to drag “Channel Title” to adjust its position.

”

* Check “Enable” to display time title in the video monitoring window; check “Disable
Time Title and it will not display.

® You can use the mouse to drag the “Time Title” to adjust its position.

* |t can be set to display preset, temperature, coordinates, zoom, location and other
information.

* Check “Enable” button to display OSD information in the video monitoring window;

OSDInfo | jjick “Disable” button and it will not display.

® You can use the mouse to drag the corresponding OSD info box to adjust the position
of “Location”. Alignment includes left alignment and right alignment.
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Parameter | Function

After you successfully set channel title, time title, OSD Info, you can click Refresh

Refresh | 1)\ tton to video the effect.

3.1.2.4 Path
The storage path interface is shown as in Figure 3-19.

Here you can set snap image saved path E in the preview interface) and the record storage path

F
in the preview interface).The snap picture default setup is C:\PictureDownload and record file
default setup is C:\RecordDownload.

Please click the Save button to save current setup.
IP PTZ Dome

Camera Video Snapshot Path
> Conditions

m Snapshot Path C:\PictureDownload
/idec.
> Audio Record Path C:\RecordDownload

Network
Ptz

Default | |

Peripheral
Event
Storage

System

Information

Figure 3-19
3.1.3 Audio
The audio interface is shown as below. See Figure 3-20.
Important

Please make sure you have enabled the video function, otherwise you cannot enable the audio
function.

31



IP PTZ Dome

Camera Audio

> Conditions
Audio Properties

> Video

| _Awo | sampingfrequency [eK =
Network Microphone Volume U 100
PT1Z Speaker Volume U 100
Peripheral Main Stream Sub Stream
Event
Storage [[] Enable [F] Enable
System Encode Mode G.711A E| Encode Mode G711A Iz‘
Information
Default | | Refresh | ‘ Save
Figure 3-20

Please refer to the following sheet for detailed information.

Parameter Function

Sampling It is to set the sampling frequency of audio
frequency

Microphone It is to set the volume of the microphone
volume

Speaker It is to set the volume of the speaker
volume

® Main stream: Recorded file only contains video by default. You need to check
the audio box here to enable audio function so that the main stream the
network transmitted is audio/video composite stream.

e Sub (Extra) stream: Recorded file only contains video by default. You need to
check the audio box here to enable audio function so that the extra stream the
network transmitted is audio/video composite stream.

Audio enable

The encode mode of the main stream and extra stream include PCM, G.711A and
Encode mode G.711Mu.

The setup here is for audio encode mode and the bidirectional talk encode both.

3.2 Network

3.2.1 TCP/IP
The TCP/IP interface is shown as in Figure 3-21.
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B EZ oo [ ve | papsck | sewp | asm_ | Logour ]

Camera TCP/IP ®

Network
HostName IPDome

> Conne Ethernet Card Wire(DEFAULT) v

> PPPoE Wode ¢ static © DHCP
> DDNS MAC Address

> IP Filter IP Version

> SMTP(Email) IP Address

> UPnP Subnet mask

> SNMP Default Gateway 172 kil

> Bonjour Preferred DNS Server | 8 8

> :
L Alternate DNS Server 8 8

> |IEEE802

¥ Enable ARP/Ping to set IP address senvice

> QoS
Ptz Default l | Refresh | | Save

Peripheral
Event
Storage
System

Information

Figure 3-21
Please refer to the following sheet for detailed information.
Parameter Function
Host Name It is to set current host device name.
Ethernet Card Please select the Ethernet port if the device has several

network cards.

Mode There are two modes: static mode and the DHCP mode.

® The IP/subnet mask/gateway are null when you select the
DHCP mode to auto search the IP.

® |f you select the static mode, you need to set the IP/subnet
mask/gateway manually.

® Besides, IP/subnet mask/gateway and DHCP are read-
only when the PPPoE dial is OK.

Mac Address It is to display host Mac address. It is read-only.
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IP Version It is to select IP version. IPv4 or IPv6.
You can access the IP address of these two versions.
® Please note system needs to check the validity of all
IPv6 addresses. The IP address and the default gatew:
shall be in the same IP section. That is to say, the
specified length of the subnet prefix shall have the sa
string.
® When PPPoE function is enabled, the IP/subnet
mask/default gateway is read-only. You cannot set or
restore default setup.
IP Address Please use the keyboard to input the corresponding number to

modify the IP address and then set the corresponding subnet
mask and the default gateway.

Default Gateway

It shall not be left in blank.

Preferred DNS

DNS IP address. It is the similar DNS of the IPv4. It shall not be
left in blank.

Alternate DNS

Alternate DNS IP address. It shall not be left in blank.

Enable
ARP/Ping set
device IP
address service.

You can use ARP/Ping command to modify or set the device IP
address if you know the device MAC address.

Before the operation, please make sure the speed dome and
the PC in the same LAN. This function is on by default.

You can refer to the steps listed below.

Step 1: Get an IP address. Set the speed dome and the PC in
the same LAN.

Step 2: Get the physical address from the label of the speed
dome.

Step 3: Go to the Run interface and then input the following
commands.

arp —s <IP Address> <MAC>

ping —| 480 —t <IP Address>

Such as: arp -s 192.168.0.125 11-40-8¢-18-10-11
ping -1 480 -t 192.168.0.125

Step 4: Reboot the device.

Step 5: You can see the setup is OK if you can see there are
output information such as “Reply from 192.168.0.125 ...” from
the command output lines. Now you can close the command
line.

Step 6: Open the browse and then input http://<IP address>.
Click the Enter button, you can access now.

3.2.2 Connection
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3.2.2.1 Connection
The connection interface is shown as in Figure 3-22.

IP PTZ Dome

Camera
Network
> TCPIP

> PPPoE

> DDNS

> |P Filter

> SMTP(Email)
> UPnP

> SNMP

> Bonjour

> Multicast

> 802.1x

> QoS

PTZ

Peripheral

Event
Storage
System

Information

Connection

Max Cennection

(1~20)

TCP Port 37FTT (1025~65534)
UDP Port 37778 (1025~65534)
HTTP Port 80
RTSP Port 554

[[] HTTPs

HTTPs

Port

Figure 3-22
Please refer to the following sheet for detailed information.
Parameter | Function
Max It is the max Web connection for the same device. The value ranges from 1
connection | to 20. The default setup is 10.
TCP port | The value ranges from 1025 to 65535. The default value is 37777. You can
input the actual port number if necessary.
UDP port | The value ranges from 1025 to 65535. The default value is 37778. You can
input the actual port number if necessary.
HTTP port | The value ranges from 1025 to 65535. The default value is 80. You can
input the actual port number if necessary.




RTSP port | ® Usually, the default value is 554. You do not need to input again if you
are using the default value. When you are using QuickTime (Apple
browser) or VLC play real-time video, you can use the following format
to play. The Blackberry also supports this function.

® Real-time monitor bit stream Url format. Please specify the channel
number, bit stream type in the Url if you are requesting real-time
monitor bit stream Rtsp stream media service. You still need to
provide user name or password if it has verification information.

® The Url format is shown as below:
rtsp://username:password@ip:port/cam/realmonitor?channel=1&subtype=0
You need to input the following items manually.
Username/password/IP/port/subtype.

The IP is device IP and the port default value is 554. You can leave it in
blank if it is the default value. The channel number begins with 1.

subtype: bit stream type, main stream is 0 (subtype=0) and extra
stream is 1 (subtype=1) .

You do not need to input the user name and password if you do not need
the verification. Such as:

Main stream: rtsp://ip:port/cam/realmonitor?channel=1&subtype=0

HTTPS It is to enable HTTPs communication service control. If you enable this
Enable function, you can use https://ip:port to login the device. In data encryption
protection mode, you can use https://ip to login if you are using the default
port.
HTTPS The HTTPs communication port value ranges from 1025 to 65535.
Port
Important

The value 0 to 1024 (excluding the default value of HTTP/RTSP/HTTPs), 1900, 3800, 5000, 5050, 9999,
37776, 37780-37880, 39999 and etc are the special ports value and they are not open for user to set.

3.2.2.2 ONVIF

ONVIF (Open Network Video Interface Forum) , the protocol describes the model, interface, data type
and data interaction mode of network video. The goal of ONVIF protocol is to realize a network video
frame agreement, which makes the network video products (including video front end, video device and
so on) from different manufacturers entirely compatible.

ONVIF function is disabled by default.
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https://ip:port
https://ip/

IP PTZ Dome

Camera Connection ONVIF
Network

> TCPIP
Defaut | [ Refresh

> PPPoE

Login Check () Enable @) Disable

> DDNS

> |P Filter
> SMTP(Email)
> UPnP

> SNMP

> Bonjour
> Multicast
> 802.1x

> QoS
PTZ
Peripheral
Event
Storage
System

Information

Figure 3-23

3.2.3 PPPoOE
The PPPOE interface is shown as in Figure 3-24.

Input the PPPOE user name and password you get from the IPS (internet service provider) and enable
PPPoE function. Please save current setup and then reboot the device to get the setup activated.

Device connects to the internet via PPPoE after reboot. You can get the IP address in the WAN from
the IP address column.

PPPOE is set to connect to the internet. You can get an account from your IPS (Internet service
provider), you can set here to dial to the interface. You can see the registered IP address in the
interface if your setup is right.

Please note, you need to go to the IP address item to view the device current device information.
You can access the client-end via this address.
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IP PTZ Dome

Camera PPPoE
Network

[C] Enable
> TCPAP

Usermname
> Connection

[ pepe |

> DDNS

> |P Filter
> SMTP(Email)
> UPnP

> SNMP

> Bonjour
> Multicast
> 802.1x

> QoS
PTZ
Peripheral
Event
Storage
System

Information

Figure 3-24

3.2.4 DDNS

The DDNS interface is shown as in Figure 3-25.

The DDNS is to set to connect the various servers so that you can access the system via the server.
Please go to the corresponding service website to apply a domain name and then access the system
via the domain. It works even your IP address has changes.

IP PTZ Dome

Camera DDNS
Network
> TCPAP

[ Server Type CN99 DDNS [=]

. Server Address
> Connection
> PPPOE Domain Name none
[ oo | L
> IP Filter Password sese
Update Period 10 Minute(1~500)

> SMTP(Email)

> UPnP |
> SNMP

‘ Refresh ‘ | Save

> Bonjour
> Multicast
> 802.1x
> QoS
PTZ

Peripheral

Event
Storage
System

Information
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Figure 3-25

Please refer to the following sheet for detailed information.

Parameter Function

Server Type You can select DDNS protocol from the dropdown list and then
enable DDNS function.

Server IP DDNS server IP address

Domain Name | Your self-defined domain name.

User The user name you input to log in the server.

Password The password you input to log in the server.

Update period | ® Device IP and service connection refresh period.
® The default setup is 10 minutes.

3.2.5 IP filter

The IP filter interface is shown as in Figure 3-26.

You can enable IP filter function so that some specified IP user can access the speed dome.
You can add IP address or IP address section.

If you do not check the box here, it means there is on access limit.

IP PTZ Dome

Camera IP Filter

Network
Trusted Sites
> TCPIP
Trusted Sites

> sctio

COmeEEE IP address IMAC address Modity Coze
> PPPoE
> DDNS

IP Filter
> SMTP(Email)
> UPnP
> SNMP
> Bonjour
> Multicast =
> 802.1x

rasnac

> QoS
PTZ | Defauk || Refish ||  Saw
Peripheral
Event

Storage

System

Information

Figure 3-26
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3.2.6 SMTP (e-mail)
The SMTP interface is shown as in Figure 3-27.

IP PTZ Dome

Camera
Network

> TCPAP

> Connection
> PPPoE

> DDNS

> |P Filter

> UPnP

> SNMP
> Bonjour
> Multicast
> 802.1x
> QoS
P1Z

Peripheral

Event
Storage
System

Information

SMTP(Email)

SMTP Server
Port
Anonymity
Usemame
Password

Sender

Authentication
Title

Mail Receiver

Interval

[C] Health Mail

none

25

nong

None [~]
Attachment
0 Second (0~3600)
Update Period Second(1~3600)
| Defatt || Refesh |[ sae

| Lve [ Playback | sewp [ Aam [ Logou |

@

Figure 3-27

Please refer to the following sheet for detailed information.

Parameter

Function

SMTP Server

Input server address and then enable this function.

Port Default value is 25. You can modify it if necessary.

Anonymity For the server supports the anonymity function. You can auto
login anonymously. You do not need to input the user name,
password and the sender information.

User Name The user name of the sender email account.

Password The password of sender email account.

Sender Sender email address.

Authentication You can select SSL or none.

(Encryption

mode)

Title (Subject)

Input email subject here.

Attachment

System can send out the email of the snapshot picture once
you check the box here.
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Parameter Function

Mail receiver Input receiver email address here. Max three addresses.

The send interval ranges from 0 to 3600 seconds. 0 means
there is no interval.

Please note system will not send out the email immediately
when the alarm occurs. When the alarm, motion detection or
the abnormity event activates the email, system sends out the
email according to the interval you specified here. This
function is very useful when there are too many emails
activated by the abnormity events, which may result in heavy
load for the email server.

Please check the box here to enable this function.

Interval

Health mail
enable

This function allows the system to send out the test email to

Update period o
check the connection is OK or not.

(interval) : .
Please check the box to enable this function and then set the
corresponding interval.
System can send out the email regularly as you set here.

Email test The system will automatically sent out an email once to test
the connection is OK or not .Before the email test, please
save the email setup information.

3.2.7 UPnP

It allows you to establish the mapping relationship between the LAN and the public network.

Here you can also add, modify or remove UPnP item..

There are two modes: manual/auto.

® Manual mode: Select an item in the list, you can modify and delete. Click Add mapping button, you
can add a new one. See Figure 3-28.

® Auto mode: The mapping is fixed and cannot be added/deleted/modified. See Figure 3-29.

In the Windows OS, From Start->Control Panel->Add or remove programs. Click the “Add/Remove

Windows Components” and then select the “Network Services” from the Windows Components Wizard.

Click the Details button and then check the “Internet Gateway Device Discovery and Control client” and

“UPnP User Interface”. Please click OK to begin installation.

Enable UPnP from the Web. If your UPnP is enabled in the Windows OS, the speed dome can auto

detect it via the “My Network Places”
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IP PTZ Dome

Camera UPnP
Network
- TR [] Enable Mode |Manual E| Router State  Mapping Failed

> Connection

Internal Port

PPPoE

WebService TCP 80 8080 Mapping Failed £ @ 5
DDNS PrivService TCP 37777 3T Mapping Failed £ (—]
IP Filter PrivService UDP 37778 37778 Mapping Failed r (-]
SMTP(Emai) RTSPService TCP 554 554 Mapping Failed £ —]

> SNMP

Bonjour

Peripheral
Event
Storage
System

Information

Figure 3-28

IP PTZ Dome

Camera UPnP
Network
> TCPAP

[C] Enable Meode |Auto E Router State  Mapping Failed
Port Mapping List

> Connection

Service Protocol Internal Port Status
PPPoE WebService TCP 30 8030 Mapping Failed B
DDNS PrivService TCP 37777 3777 Mapping Failed
IP Filter PrivService UDP arrie 7T7e Mapping Failed
SMTP(Emai) RTSPService TCP 554 554 Mapping Failed

> SNMP
> Bonjour

> Multicast

> 802.1x

> QoS
PTZ

Peripheral

Event
Storage
System

Information

Figure 3-29

3.2.8 SNMP
The SNMP interface is shown as in Figure 3-30.
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The SNMP allows the communication between the network management work station software and the
proxy of the managed device. Please install the software such as MG MibBrowser 8.0c software or
establish the SNMP service before you use this function. You need to reboot the device to activate the
new setup.

IP PTZ Dome

Camera SNMP

Network
SNMP Port 161 (1~65535)
> TCPIP
Read Community public
> Connection
> PPPoE Write Community private
> DONS Trap Address
> IP Filter Trap Port 162 (1-65535)
> SMTP(Email) ClEeeriine
> UPnP SNMP Version [CISNMP v1 []SNMP v2 []SNMP v3
SIS Defaut || Reesn ||  sawe
> Bonjour
> Multicast

> 802.1x
> QoS
PTZ

Peripheral

Event
Storage
System

Information

Figure 3-30
Please refer to the following sheet for detailed information.
Parameter Function
SNMP Port The listening port of the proxy program of the device. Itis a

UDP port not a TCP port. The value ranges from 1 to 65535.
The default value is 161

Itis a string. It is a command between the manage process
and the proxy process. It defined the authentication, access
control and the management relationship between one proxy
and one group of the managers. Please make sure the device
and the proxy are the same.

The read community will read all the objects the SNMP
supported in the specified name. The default setup is public.
Itis a string. It is a command between the manage process
and the proxy process. It defined the authentication, access
control and the management relationship between one proxy
and one group of the managers. Please make sure the device
and the proxy are the same.

The read community will read/write/access all the objects the
SNMP supported in the specified name. The default setup is
private.

Read Community

Write Community
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Parameter Function

Trap address The destination address of the Trap information from the
proxy program of the device.
Trap port The destination port of the Trap information from the proxy

program of the device. It is for the gateway device and the
client-end PC in the LAN to exchange the information. It is a
non-protocol connection port. It has no effect on the network
applications. It is a UDP port not TCP port. The value ranges
from 1 to 165535. The default value is 162.

SNMP version o th\(?ik SNMP v1, system only processes the information
0 .

® Check SNMP v2, system only processes the information
of V2.

® Check SNMP v3, you can set account and password. You
need to set the corresponding account and password for
security verification when the server wants to access the
device. At the same time, the V1 and V2 option is null.

3.2.9 Bonjour

The Bonjour interface is shown as below. See Figure 3-31.

Bonjour is based on the multicast DNS service from the Apple. The Bonjour device can automatically
broadcast its service information and listen to the service information from other device.

You can use the browse of the Bonjour service in the same LAN to search the speed dome device and
then access if you do not know the speed dome information such as IP address.

You can view the server name when the speed dome is detected by the Bonjour. Please note the safari
browse support this function. Click the “Display All Bookmarks: and open the Bonjour, system can auto
detect the speed dome of the Bonjour function in the LAN.
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> TCPIP

. Server Name PZBABN290W00008
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> PPPoE Defat ||  Refesh ||
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> P Filter
> SMTP(Email)
> UPnP

> SNMP

> Multicast
> 802.1x

> QoS
PTZ
Peripheral
Event
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System
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Figure 3-31

3.2.10 Multicast

The multicast interface is shown as in Figure 3-32.

Multicast is a transmission mode of data packet. When there is multiple-host to receive the same data
packet, multiple-cast is the best option to reduce the broad width and the CPU load. The source host
can just send out one data to transit. This function also depends on the relationship of the group
member and group of the outer.

Here you can set multicast address and port. You also need to go to Live interface to set the protocol as
Multicast.
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IP PTZ Dome

Camera
Network
> TCPIP
> Connection
> PPPoE
> DDNS
> IP Filter
> SMTR(Email)
> UPnP
> SNMP
> Bonjour

| Mutcast |
> 802.1x
> QoS
PTZ
Peripheral
Event

Storage

System

Information

Multicast

Main Stream
Enable
Multicast Address 239 . 255 . 42 . 42 |(224.0.0.0~239 255255 255)
Port 36666 (1025~65534)
Sub Stream
[C] Enable
Multicast Address 239 . 255 . 42 . 42 |(224.0.0.0~238 255 255 255)
Port 36667 (1025~65534)
|| memesn ||  sae

Figure 3-32

3.2.11 IEEE802

IEEE802.1X works standing for local and metropolitan area networks and port based network access
control protocol. It supports manual operation of the client to choose means of authenticating by which
to control it to access to the Local Area Networks or not. It supports the ability to authenticate, to
calculate fee, to ensure security and to maintain requirements. See Figure 3-33.

IP PTZ Dome

Camera
Network
> TCP/IP

802.1x

[] Enable
. Authentication
> Connection

> PPPOE Usermame:

> DDNS Password

> IP Filter

> SMTP(Emai)
> UPnP
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> Bonjour
> Multicast
> QoS
PTZ
Peripheral
Event
Storage

System

Information

46



Figure 3-33

Please refer to the following sheet for detailed information.

Parameter Function

Authentication | PEAP (protected EAP protocol).

Username It needs the username to login, which is authenticated by the
server.
Password Please input password here.
3.2.12 Qos

The QoS interface is shown as below. See Figure 3-34.

Qos (Quality of Service) is network security mechanism. It is a technology to fix the network delay and
jam problem and etc. For the network service, the quality of service includes the transmission bandwidth,
delay, the packet loss and etc. We can guarantee the transmission bandwidth, lower the delay, and
reduce the loss of the data packet and anti-dither to enhance the quality.

We can set the DSCP (Differentiated Services Code Point) of the IP to distinguish the data packet so
that the router or the hub can provide different services for various data packets. It can select the
different queues according to the priority of the packets and select the bandwidth of the each queue. It
can also discard at the different ratio when the broad bandwidth is jam.

IP PTZ Dome

Camera QoS
Network
> TCPIP

Realtime Monitor

Command
> Connection

> PPPoE

> DDNS

> IP Filter

> SMTP(Email)

> UPnP

> SNMP

> Bonjour

> Multicast

> 802.1x
TSI

PTZ

Peripheral

Event

Storage

System

Information

Figure 3-34
Please refer to the following sheet for detailed information.
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Parameter Function

Real-time The data packet of the network video monitor.

monitor

Command The non-monitor packet such as device setup and search.
3.3 PTZ

3.3.1 Protocol
3.3.1.1 Network PTZ Setup
Network PTZ setup interface is shown as in Figure 3-35.

UFLAZ BB [ uve [ Paypsck | sewp | mam_ | Logour

Camera Network PTZ Analog PTZ @
Protocol DH-SD1 Z

_ Protocol " l Default | | Refresh | | Save

Network
Ptz

> Function
Peripheral
Event
Storage
System
Information

Figure 3-35
Please refer to the following sheet for detailed information.
Parameter Function
Protocol You can select from the dropdown list such as DH-SD1/DH-SD3

3.3.1.2 Analog PTZ
The analog PTZ is shown as in Figure 3-36.

IP PTZ Dome

Camera Network PTZ Analog PTZ
Network

Ptz

Address 1

Baudrate 9600 Y

(GloCcol

= i Data Bit
> Function
Peripheral Stop Bt :I

Parity None 57

Event

Storage l Default | | Refresh | | Save
System

Information

Figure 3-36
48



Please refer to the following sheet for detailed information.

Parameter Function

Address It is to set the corresponding speed dome address. The default
setup is 1.

Baud rate It is to set the baud rate of the camera. The default setup is
9600.

Data bit The default setup is 8.

Stop bit The default setup is 1.

Parity You can set protocol parity mode. The default setup is none.

3.3.2 Function

IP PTZ Dome

Camera Function
Network
PT1Z

» Tour
> Protocol

Peripheral

» Scan

» Patten
Pan
PTZ Speed
Idle Motion

»
Event
»
»
» Bootup
»
»

Storage

System

Information

PTZRestart | [} a4q ||o Refresh “ﬁ Clear
Default

IPPTZ Dorme

Figure 3-37
In this part, you can operate the PTZ of the camera and control PTZ movement.
Parameter Function
Preset Set camera preset.
Tour Set camera tour. Max 8 tours.
Scan Set camera scan.
Pattern Set camera pattern.
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Pan Set camera rotation speed.
PTZ speed Set PTZ movement speed.
Idle motion Set camera idle operation.
Power up Set camera operation when system boots up.

PTZ restart

Restart camera PTZ.

Default

Restore camera PTZ default setup.

3.3.2.1 Preset
Preset interface is shown as in Figure 3-38.

IP PTZ Dome

Camera
Network
PT1Z

> Protocol

Peripheral
Event
Storage
System

Information

Figure 3-38
Please refer to the following sheet for detailed information.
Parameter Function
Preset No. Set preset No. It becomes valid after you set.
Preset title Set preset name. You can input self-defined preset name here.
Delete Delete corresponding preset.

Function

» Tour
» Scan

» Pattern
Pan

PTZ Speed
Idle Motion
Boot up v

vy v v v v v

PTZRestat | [3 adg ”@ Refresh ||i Clear
Default
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Save

Save current preset setup.

Add

Click it to add a new preset.

Clear

Clear all presets setup.

3.3.2.2 Tour

Tour interface is shown as below. See Figure 3-39.

IP PTZ Dome

Camera Function

Network
PTZ

> Protocol
Peripheral
Event
Storage
System

Information

E R 0 26 Fri TR Tour No. Tour Name Delete

» Tour

» Scan

Pattern

Pan

»
»

» PTZ Speed

p Start + Add

» Idle Motion I—l
»

»

»

Hork ins No. Preset Duration(s) Delete

PTZ Restart
Default

+ Add||d sae ”ct Refresh

Figure 3-39
Please refer to the following sheet for detailed information.
Parameter Function
Tour No. System auto allocates.
Tour title Set tour name. You can input self-defined tour name here.
Begin or stop tour.
Start /Stop Please note this function is null if you have not set a tour.
Add Click it to add a new tour.
Click Add button, you can add a new tour. The default preset
Preset value is 1.
Double click tour No, you can see a dropdown list for you to
select.
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Please set presets before you use tour function.

Duration
(Interval)

It is to set the staying time of the tour.

Save

Click it to save current setup.

Refresh

Refresh current interface.

3.3.2.3 Scan

Scan interface is shown as below. See Figure 3-40.

IP PTZ Dome

Camera Function

Network

zfgtflc--".’.-isl BEE4C:40 Fri N ScanNo: [1 E'
PTZ - -
> Protocol e pead E‘ U \35
. —— ——
» Pattern |
Peripheral
Event e
» PTZ Speed
Storage
» Idle Motion
System
» Bootup
Information
» PTZ Restart
» Default
Figure 3-40
Please refer to the following sheet for detailed information.
Parameter Function
Scan No. System auto allocates.
Set scan speed here.
Speed . .
You cannot set speed when camera is running scan.
Begin or stop scan.
r ; L .
Start/Stop Please note this function is null if you have not set a scan.
Set Click set button, you can set left limit and right limit.
Left limit Set camera left limit.
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Right limit

Set camera right limit.

3.3.2.4 Pattern
Pattern interface is shown as below. See Figure 3-41.

IP PTZ Dome

Camera
Network
PTZ

> Protocol

_ Function
Peripheral
Event
Storage
System

Information

Function

L EH RIS BRI 5015 Fri » Preset Pattern No. | 1 E[
o B e
» PTZ Speed
» Idle Motion
» Bootup
» PTZ Restart
» Default
Figure 3-41
Please refer to the following sheet for detailed information.
Parameter Function
Pattern No. System auto allocates.
Begin or stop pattern.
Start /Stop Please note this function is null if you have not set a
pattern.
Set Click it you can see start/stop record buttons.

Start record

Click it to begin recording pattern setup.

Stop record

Click it to stop recording pattern setup.

3.3.2.5 Pan
Pan interface is shown as below. See Figure 3-42.
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IP PTZ Dome

Camera
Network
PTZ

> Protocol
Peripheral
Event
Storage
System

Information

PTZ Speed
Idle Motion
Boot up
PTZ Restart
Default

Figure 3-42

Please refer to the following sheet for detailed information.

Parameter

Function

Pan speed

Itis to set camera pan speed.

Start /Stop

Check it to start or stop pan movement.

3.3.2.6 PTZ speed

PTZ speed interface is shown as below. See Figure 3-43.
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IP PTZ Dome

Camera Function
Network 2 05:01 200 Mon

Preset
Ptz PTZSpeed ¢ Low  Middle ¢ High
Tour
> Protocol

| Funcion | S

Pattern
Peripheral

Pan
Event
Privacy Mask
» PTZ Speed

» lIdle Motion

Storage
System

Information
» PowerUp

» PTZRestart

» Default

Figure 3-43

Please refer to the following sheet for detailed information.

Parameter Function

PTZ speed Here you can set camera PTZ speed.

3.3.2.7 Idle Motion
Idle motion interface is shown as below. See Figure 3-44.

IP PTZ Dome

Camera Function
Network

Ptz

05:01- 42 R Mon
Preset Enable [~

Tour Idle Motion ¢ Preset © Tour
> Protocol

e Scan  scan { Pattern
~ Function

) Pattern Idle Time |10 Minute
Peripheral

Pan
Privacy Mask

Storage
PTZ Speed

Idie Motion

System

Information
» PowerlUp

» PTZRestart

» Default
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Figure 3-44

Please refer to the following sheet for detailed information.

Parameter Function

Enable Check the box here to enable idle motion function.

Here you can set preset, scan, pattern, tour.
Idle Motion Please note you need to set the corresponding
operation first if you want to use this function.

Idle time Set idle time.
3.3.2.8 Power up
Power up interface is shown as below. See Figure 3-45.

IP PTZ Dome

Camera Function
Network

Ptz

~22-201305:02.05 B Men
Enable

PowerUp Preset  Tour
Scan  Pattern

»
»
»
Nk ' Auto
»
>
»
»

> Protocol
Peripheral

Privacy Mask
Storage

PTZ Speed
System

Idle Motion

Information

» PTZRestart

» Default

Figure 3-45

Please refer to the following sheet for detailed information.

Parameter Function

Enable Check the box here to enable power up function.

Here you can set preset, scan, pattern, tour and auto.
Power up Please note you need to set the corresponding
function first if you want to useit.

3.3.2.9 PTZ Restart
PTZ restart interface is shown as below. See Figure 3-46.
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IP PTZ Dome

Camera Function
Network

Ptz

> Protocol
Peripheral
Event
Storage
System
Information

Preset
Tour

Scan

Pan

Privacy Mask

»
»
»

. » Pattern
L3
»
»

PTZ Speed
» Idle Motion
> PowerUp

» PTZRestart

» Default

Figure 3-46

Please refer to the following sheet for detailed information.

Parameter

Function

PTZ restart

Itis to reboot PTZ.

3.3.2.10 Default

Default interface is shown as below. See Figure 3-47.

IP PTZ Dome

Camera Function
Network

Ptz

> Protocol
Peripheral
Event

Storage

System

Information

Preset

Tour

Scan
Pattern

Pan

Privacy Mask
PTZ Speed
Idle Motion
PowerUp
PTZ Restart

Figure 3-47
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Please refer to the following sheet for detailed information.

Parameter Function

Default Restore PTZ factory default setup.

3.4 Peripheral

3.4.1 IR Light

Important

Please make sure your purchased camera supports all the functions listed here.

The IR light has two interface: zoom has the priority(Figure 3-48)/manual has the priority(Figure 3-49).

IP PTZ Dome

Camera IR Light

Network
o Mode |ZoomPrio [~]
Peripheral IR Compensation E| U [+]3
Storage
System
Information

IR PTZ Dorma.

Figure 3-48
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IP PTZ Dome

Camera IR Light
Network

Mode |Manual
P1Z =]

Near light [ (_je— | 0

Far light [ ( jm— ] O

Peripheral

> Wiper
Event
Storage
System

Information

@ @ Zoom (—)
® = ©
®

Iris

Figure 3-49
Please refer to the following sheet for detailed information.
Parameter Function
Zoom has the | Enable IR light when the zoom has the priority. The IR light near
priority light value/far light value can automatically switch according to the
zoom.
Manual has You can set IR light near/far value under manual mode.
the priority
3.4.2 Wiper

IP PTZ Dome

Camera Wiper
Network

Mode Timing
PTZ

Interval Ti
Peripheral et iime

Period
> IR Light 0 Pen

Event

Storage
System

Information

Figure 3-50
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Parameter Function

Mode Able to select manual and timing, timing is default.

Interval time The interval from the wiper stops to it begins.

Check enable, and you can set the period when the wiper enables. (it only

Period exists when the mode is “Timing”)

3.5 Event

3.5.1 Video detect
3.5.1.1 Motion Detect
The motion detect interface is shown as in Figure 3-51.

IP PTZ Dome

Camera Motion Detect
Network
PTZ

Peripheral Working Period

Event Anti-Dither o] Second{0~100)

e rere—

[7] Enable

> Alarm Manual Control Excluded
> Abnormality
Record
Storage
Record Delay 10 Second(10~300)
System i =
Relay-out
Information !
Alarm Delay 10 Second(10~300)
[C] Send Email
O PTZ
[] Snapshot

Working Period [ %]

[l Sunday [] Monday [] Tuesday [] Wednesday [ Thursday [] Friday [] Saturday
[ Period 1 00:00:00 | 23:89:58
[ Period 2 00.00:00 | 23:.59:58
[ Period 3 00 00 00 — 23 59:53
[ Perind 4 00 00 00 — 2359:53
[ Period 5 000000 | 235958
[ Period & 00:00:00 | 23:89:58

Save Cancel
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Figure 3-52

[ ]
|
1
Save | | Gancel
Figure 3-53
Please refer to the following sheet for detailed information.
Parameter Function
Enable You need to check the box to enable motion detection function.
Region * There are six levels. The sixth level has the highest sensitivity.
¢ Region: If you select motion detection type, you can click this
button to set motion detection zone. The light blue zones are
the valid motion detect area. All areas are the valid motion
detect zone by default. You can use mouse to set invalid area.
¢ Do remember clicking OK button to save your motion detection
zone setup.
Working ¢ Motion detection function becomes activated in the specified
Period periods. See Figure 3-52.
* There are six periods in one day. Please draw a circle to enable
corresponding period.
¢ Select date. If you do not select, current setup applies to today
only. You can select all week column to apply to the whole
week.
¢ Click OK button, system goes back to motion detection
interface; please click save button to exit.
Anti-dither System only memorizes one event during the anti-dither period.
The value ranges from Os to 100s.
'(\:Agr?tl: gll Check to select, and manual control PTZ will not disable motion
detect function actively.
Excluded
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Parameter

Function

Record
channel

System auto activates motion detection channel to record once
motion detect alarm occurs (working with motion detection
function). Please note you need to go to Storage-> Schedule to
set motion detect record period and go to Storage->Record
control to set current channel as auto record.

Record Delay

System can delay the record for specified time after motion detect
alarm ended. The value ranges from 10s to 300s.

Relay out

Enable alarm activation function. You need to select alarm output
port so that system can activate corresponding alarm device when
alarm occurs.

Please note the relay output number here is for reference
only. The alarm output number may vary due to different
series products.

Alarm Delay

System can delay the alarm output for specified time after motion
detect alarm ended. The value ranges from 10s to 300s.

Send Email

If you enabled this function, System can send out email to alert
you when alarm occurs and ends.

PTZ

* Here you can set PTZ movement when alarm occurs. Such as
go to preset x when there is an alarm.

* The event type includes: preset, tour and pattern and etc.

Snapshot

It is snapshot activation function.

3.5.1.2 Video Masking
The video masking interface is shown as in Figure 3-54.

IP PTZ Dome

Camera
Network
Ptz
Peripheral

Event

> Alarm

> Abnormality
Storage
System

Information

Motion Detect
I” Enable
Working Period

v Record
Record Delay

IV Relay-out
Alarm Delay

I” Send Email

I~ P1Z

I” Snapshot

Video Masking

Second(10~300)

Second(10~300)

Default | | Refresh ' |

Figure 3-54
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Please refer to the following sheet for detailed information.

Parameter Function

Enable You need to check the box to enable video masking function.
Working ¢ Video masking function becomes activated in the specified
Period periods.

* There are six periods in one day. Please draw a circle to enable
corresponding period.

* Select date. If you do not select, current setup applies to today
only. You can select all week column to apply to the whole
week.

® Click OK button, system goes back to motion detection
interface; please click save button to exit.

Anti-dither System only memorizes one event during the anti-dither period.

The value ranges from 0s to 100s.

Record System auto activates motion detection channel to record once
channel video masking alarm occurs (working with motion detection

function). Please note you need to go to Storage-> Schedule to
set motion detect record period and go to Storage->Record
control to set current channel as auto record.

Record Delay

System can delay the record for specified time after video
masking alarm ended. The value ranges from 10s to 300s.

Relay out Enable alarm activation function. You need to select alarm output
port so that system can activate corresponding alarm device when
alarm occurs.

Please note the relay output number here is for reference
only. The alarm output number may vary due to different
series products.

Alarm Delay System can delay the alarm output for specified time after motior]
detect alarm ended. The value ranges from 10s to 300s.

Send Email If you enabled this function, System can send out email to alert
you when alarm occurs.

PTZ e Here you can set PTZ movement when alarm occurs. Such as

go to preset x when there is an alarm.
* The event type includes: preset, tour and pattern and etc.

Snapshot It is snapshot activation function.

3.5.2 Alarm

The alarm activation interface is shown as in Figure 3-55.



IP PTZ Dome

Camera Relay Activation
Network

Ptz

I” Enable

% Relay-in
Peripheral

Event Working Period
> Video Detect Anti-Dither

> Abnormality

W Record

Record Delay

Storage

¥ Relay-out
System

. Alarm Delay

Information

I” Send Email

I~ P12

™ Snapshot

e | paypask | sewe | aam._[_ogout ]

Alarm1 X,

0 Second(0~100)  SensorType [NO B

Second(10~300)

Second(10~300)

Default ‘ | Refresh l | Save

@

Figure 3-55

Please refer to the following sheet for detailed information.

Parameter

Function

Enable

You need to check the box to enable this function.

Working
Period

® This function becomes activated in the specified periods.

® There are six periods in one day. Please draw a circle to enable
corresponding period.

* Select date. If you do not select, current setup applies to today
only. You can select all week column to apply to the whole
week.

¢ Click OK button, system goes back to motion detection
interface; please click save button to exit.

Anti-dither

System only memorizes one event during the anti-dither period.
The value ranges from 0s to 100s.

Sensor type

There are two options: NO/NC. From NO to NC, system enables
alarm. From NC to NO, system disables alarm.

Relay out

e Enable alarm activation function. You need to select alarm
output port so that system can activate corresponding alarm
device when alarm occurs.

® Please note the relay output number here is for reference
only. The alarm output number may vary due to different
series products.

Alarm Delay

System can delay the alarm output for specified time after alarm

ended. The value ranges from 10s to 300s.
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Parameter

Function

Record
Channel

System auto activates motion detection channel to record once
alarm occurs (working with motion detection function). Please
note you need to go to Storage-> Schedule to set current channel
as general record.

Record Delay

System can delay the record for specified time after alarm ended.
The value ranges from 10s to 300s.

Send Email If you enabled this function, System can send out email to alert
you when alarm occurs and ends.
PTZ * Here you can set PTZ movement when alarm occurs. Such as
go to preset x when there is an alarm.
* The event type includes: preset, tour and pattern.
Snapshot You need to input capture channel number so that system can

backup motion detection snapshot file.

3.5.3 Abnormality
It includes five statuses: No SD card, capacity warning, SD card error, and disconnection and IP conflict.
See Figure 3-56 through Figure 3-60.

IP PTZ Dome

Camera
Network
Ptz
Peripheral
Event

> Video Detect
> Alarm
___Abnormality
Storage
System

Information

No SD Card

I” Enable
IV Relay-out
Alarm Delay

I” Send Email

Capacity Warning SD Card Error Disconnection IP Confiict

Second(10~300)

Default I | Refresh

Figure 3-56

[ F 7 ETIE [ uve | ook | sewp | wsm | togou

Camera No SD Card IP Conflict (@)
Network

Ptz

Capacity Warning SD Card Error Disconnection

I” Enable

Capacity Limit %(0~99)
Peripheral Ras (-89)
v Relay-out
Event g

A ~
> Video Detect larm Delay Second(10~300)

r -
> Alarm Send Email

Default I | Refresh

Storage

System

Information
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Figure 3-57

LA LA e L opapaok | sewe | aam | _togout ]

Camera No SD Card Capacity Waming SD Card Error Disconnection IP Conflict @
Network

Ptz

I” Enable

IV Relay-out

Peripheral
Alarm Delay Second(10~300)

I” Send Email

Event

> Video Detect

> Alarm Default I l Refresh | |

Storage

System

Information

Figure 3-58

IP PTZ Dome ST TR TR AT AT

Camera No SD Card Capacity Warning SD Card Error Disconnection IP Confiict @
Network

Ptz

I” Enable

) V¥ Recard
Peripheral

Record Delay Second(10~300)

V¥ Relay-out

Event

> Video Detect
A Alarm Delay Second(10~300)

Default | l Refresh | |

Storage

System

Information

Figure 3-59

A RIS v Lramase | sewe L aam [ togout.. |

Camera No SD Card Capacity Warning SD Card Error Disconnection IP Conflict @
Network

Ptz

Peripheral

I” Enable
¥ Record

Record Delay Second(10~300)
¥ Relay-out

Event
> Video Detect

> A Alarm Delay Second(10~300)

Default | | Refresh ' ‘

Storage

System

Information

Figure 3-60

Please refer to the following sheet for detailed information.
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Parameter | Function
Event * The abnormal events include: no SD card, no space, SD card error,
Type disconnection, IP conflict.
* You need to draw a circle to enable this function.
Record System auto activates channel to record once an alarm occurs (For
disconnection type only. See Figure 3-59. ).
You need to check the box to enable this function.
Record System can delay the record for specified time after alarm ended. The
Delay value ranges from 10s to 300s.
Relay Out | The corresponding alarm output channel when alarm occurs. You need
to check the box to enable this function.
Relay out | The alarm output can delay for the specified time after alarm stops. The
Delay value ranges from 10s to 300s.
Send If you enable this function, system can send out email to alarm the
email specified user.
3.6 Storage

3.6.1 Record schedule and snapshot schedule/Holiday

In these two interfaces, you can add or remove the schedule record/snapshot setup. See Figure 3-61.

There are three record modes: general (auto), motion detect and alarm. There are six periods in one
day. Please make sure you have enabled the corresponding record mode in the Setup->Storage-
>Conditions.

You can view the current time period setup from the color bar.

® Green color stands for the general record/snapshot.

® Yellow color stands for the motion detect record/snapshot.

® Red color stands for the alarm record/snapshot.

In the holiday schedule interface, you can set special dates as holiday. Once you enable
record/snapshot function here, system can record/snapshot according to your setup on the holiday
schedule interface.
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IP PTZ Dome

Camera
Network
Ptz
Peripheral
Event

Storage

> Destination
> Record Control
System

Information

T e TR ST ST

Holiday Schedule ®

Record Schedule Snapshot Schedule

Sunday |
Monday

Tuesday |

Wednesday |

Thursday |
Friday
Saturday

Holiday |______

Defautt | | Refresn

Figure 3-61

3.6.2 Destination

The destination interface is shown as in Figure 3-62.

It is to set the storage mode of the speed dome record file or snapshot pictures. There are three options:
path/local storage/FTP. You can only select one mode. System can save according to the event types.

It is corresponding to the three modes (general/motion/alarm) in the Schedule interface. Please check
the box to enable the save functions.

IP PTZ Dome

Camera
Network

Ptz
Peripheral
Event
Storage

> Schedule
Destination

> Record Control

System

Information

Path

Record Snapshot

Event Type Scheduled Motion Detect Alarm Event Type Scheduled Motion Detect Alarm

Local v v v Local v v v
FTP )] | r FTP )i § r

Refresh | |

Default | |

Figure 3-62
Please refer to the following sheet for detailed information.
Parameter | Function
Event It includes: general, motion detect and alarm.
Type
Local It is to save in the SD card.
FTP It is to save in the FTP server.
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The local interface is shown as in Figure 3-63. Here you can view local SD card information. You can
also operate the read-only, write-only, hot swap and format operation.

RS tone [ uve | pasck | sews | asm_ | togou ]
Camera @

Network
Ptz
Peripheral

Event

Storage

> Schedule

> Record Control

System

Information

Readonly | | Reasawite | | Hotswap | [  Refresn

Figure 3-63

The FTP interface is shown as in Figure 3-64. You need to check the box to enable the FTP function.
When network disconnect occurred or there is malfunction. Emergency storage can save the
record/snapshot picture to the local SD card.

IP PTZ Dome

Camera Path
Network
Ptz

I” Enable
- Server Address
Peripheral

B -
Event S 21 (0-85535)

anonymity
storage User Name ymity

> Schedule Password

Remote directory share

> Record Control I”™ Emergency (Local)

System Default l I Refresh i I

Information

Figure 3-64

3.6.3 Record control
The record control interface is shown as in Figure 3-65.
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L HEC e [ papsck [ sewp [ aam ] Logout. ]

Camera Record Control @
Network
Ptz

Peripheral

Pack Duration 30 Minute (1~120)

Pre-event Record 5 Second (0~5)

Disk Full Overwrite ¥

Record Mode @« Aute O Manual ¢ Off

Event

Storage

> Schedule Record Stream Main Stream -

> Destination | Default | | Refresh | | Save

__Record Con

System

Information

Figure 3-65

Please refer to the following sheet for detailed information.

Parameter Function

Pack Here you can select file size. Default setup is 60 minutes.
Duration

Pre-record | Please input pre-record value here.

For example, you can input 4 here so that system can read the
previous four seconds video before the alarm occurrence from the
buffer and record the 4 seconds video in the file.

Please note, if there is no record when alarm record or motion detect
record occurred, system can record the N seconds’ video before the
event occurrence in the file.

Disk Full There are two options: stop recording or overwrite the previous files

when HDD is full.

® Stop: Current working HDD is overwriting or current HDD is full,
it will stop record.

® Overwrite: Current working HDD is full; it will overwrite the
previous file.

There are three modes: Auto/manual/close.

Record
Mode

Record Bit You can select main stream or extra stream.

Stream

3.7 System

3.7.1 General

The general interface includes the general setup and the date/time setup.
3.7.1.1 General

The general interface is shown as in Figure 3-66.
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LA OIS [ ve [ raypsck | sewp | asm_ | Logour ]

Camera General Date&Time @
Network

Ptz
Peripheral

Device Name YZB3F\W02100002

Language English 57

Video Standard NTSC e
Event

Storage l Default l | Refresh

System
> Account
> Default
> Import/Export
> Auto Maintain

> Upgrade

Information

Figure 3-66

Please refer to the following sheet for detailed information.

Parameter Function

Device It is to set device name.

Name

Video This is to display video standard.
Standard

Language You can select the language from the dropdown list.

The browser can refresh automatically and change the language
accordingly.

3.7.1.2 Date and time
The date and time interface is shown as in Figure 3-67

L2 AIE [ ve [ paypsck | sewp | mam_ | Logow |

Camera General Date&Time @
Network

Date Format Month-Day-Year Y
Ptz

_ Time Format 12-Hour-based System v
Peripheral
Time Zone GMT+08:00 >
Event
i iz -2013 5 5 5 TR i
storage Current Time 07 22 -2013| 05 0 PM

system I” DST Enable

m DST Type " Date  Week

> Accotmit Start Time |Jan j i1st LI |Monday
> Default End Time [Dec ~|[1st | [Monday
> Import/Export I™ Synchronize with NTP

> Auto Maintain NTP Server clock.iscorg
> Upgrade Port 123

Information Update Period Minute(0~30)

Default I | Refresh

Figure 3-67
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Please refer to the following sheet for detailed information.

Parameter

Function

Date format

Here you can select date format from the dropdown list.

There are two options: 24-H and 12-H.

Time

Format

Time zone | The time zone of the device.

System It is to set system time. It becomes valid after you set.

time

Sync PC You can click this button to save the system time as your PC current
time.

DST Here you can set day night save time begin time and end time. You
can set according to the date format or according to the week
format.

NTP You can check the box to enable NTP function.

NTP server | You can set the time server address.

Port It is to set the time server port.

Update It is to set the sync periods between the device and the time server.

period The update function is null if the value is 0.

System only synchronizes once when the setup is 0.

3.7.2 Account

Note:

For the character in the following user name or the user group name, system max supports 15-
digits. The space in the front or at the end of the string is null. The valid string includes: character,
number, and underline.
The max user amount is 20 and the max group amount is 8. You can add or delete user group.

The factory default setup includes two levels: user and admin. .User management adopts
group/user modes. The user name and the group name shall be unique. One user shall be included
in only one group.

3.7.2.1 User name
In this interface you can login anonymously, add/remove user and modify user name. See Figure 3-68.

Check the box to login anonymously, you can input IP address on the browser, system goes to Live

interface directly.
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IP PTZ Dome

Camera Account
Network

[7] Ancnymous Login
PTZ
. Username
(RETFIEE Group Name [rm—— Modify Delete
Event 1 admin admin admin 's account i -] -
Storage
System
> General
Account

> Default
> Import/Export il
> Auto Maintain

Authority List
Z\pade Live Playback Record control Backup PTZ Account Alarm
Information Log Search Clear Log Upgrade Auto Maintain General Video/Audio Schedule/Destination

Network Abnormality Video Detect PTZ Settings Default/import/Export ~ Conditions IR Light Control

Wiper Control Camera medule control

Add user: Itis to add a name to group and set the user rights. See Figure 3-69.
Here you can input the user name and password and then select one group for current user.

Please note the user rights shall not exceed the group right setup.

For convenient setup, please make sure the general user has the lower rights setup than the admin.
Add User X

User Name
Password

Confirm Password

Group |admin L]
Remark 7
Authority List VAl
¥ Live i‘
¥ Playback
V¥ Record control
IV Rackun .L]
| Save I | Cancel I
Figure 3-69

Modify user

It is to modify the user property, belonging group, password and rights. See Figure 3-70.
Modify password
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It is to modify the user password. You need to input the old password and then input the new password
twice to confirm the new setup. Please click the OK button to save.
For the user of the account rights, he can modify the password of other users.

Modify User &8

]admin j

User Name

I™ Modify Password

Group I _J
Remark
Authority List 7 Al
I Live il
¥ Playback
I Record control
[¥ Rackun _:J
[ Save I | Cancel ]
Figure 3-70

3.7.2.2 Group
The group management interface can add/remove group, modify group password and etc.
The interface is shown as in Figure 3-71.

IP PTZ Dome

Camera Account
Network

Ptz

IV Anonymous Login

Peripheral
Event
Storage
System

> General

> Default
> Import/Export
> Auto Maintain
> Upagrade
Information

User Name

Group
Group Name
admin
user

administrator group
user group

Authority List
Live

Clear Log
Video Detect

Playback
Uparade
PTZ Settings

Record control Backup
Auto Maintain General
DefaultimportExport  Conditions

PTZ Account

Vids d

Schedule/Destil

LightingConf

Alarm
Network

Log Search
Abnormality

Add Group

Figure 3-71

Add group: Itis to add group and set its corresponding rights. See Figure 3-72.
Please input the group name and then check the box to select the corresponding rights. It includes: live
playback, record control, backup, PTZ control, user management and etc.
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Add Group X}

Group
Remark
Authority List Al
I Live i]
™ Playback
I” Record control
I Rackun -l]
| Save I l Cancel |
Figure 3-72

Modify group
Click the modify group button, you can see an interface is shown as in Figure 3-73.
Here you can modify group information such as remarks and rights.

Modify Group

Group [admin L]
Remark administrator group
Authority List VAl
-~
W Live
IV Playback

¥ Record control

V¥ Rackun ._:J

I Save I I Cancel l

Figure 3-73

3.7.3 Default
The default setup interface is shown as in Figure 3-74.
Please note system cannot restore some information such as network IP address.



il TR A ST AT T

Camera Default @
Network

P

Peripheral

Event
Storage
System

> General

> Account

> Import/Export
> Auto Maintain
> Upgrade
Information

Figure 3-74

3.7.4 Import/Export
The interface is shown as in Figure 3-75.

LA [T e TR ST ST

Camera Import/Export @
Network

Backup Path
Ptz

Peripheral Import

Event
Storage
System
> General
> Account

> Default

> Auto Maintain

> Upgrade

Information

Figure 3-75

Please refer to the following sheet for detailed information.

Parameter | Function

Import It is to import the local setup files to the system.

Export It is to export the corresponding system setup to your local PC.

3.7.5 Auto maintenance
The auto maintenance interface is shown as in Figure 3-76.
Here you can select auto reboot and auto delete old files interval from the dropdown list.

If you want to use the auto delete old files function, you need to set the file period.
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Camera Auto Maintain @
Network

V¥ Auto Reboot Tuesday >|| 02 : 00
Ptz

I™ Auto Delete Old Files

Peripheral

Event Manual Reboot

Storage |

Refresh | | Save

System

> General

> Account

> Default

> Import/Export
AULO niain

> Upgrade

Information

Figure 3-76

3.7.6 Firmware update

The firmware interface is shown as in Figure 3-77.

Please select the upgrade file and then click the update button to begin firmware update.

Important

Do not turn off the device power, disconnect the device, reboot or shutdown the device during
the update period.

Please reboot the device if you update the improper program, otherwise some function module
of the device may become null!

gzl AT A R TN AT

Camera Upgrade @
Network

Ptz Select Firmware File Upagrade

Peripheral

Event
Storage
System

> General

> Account

> Default

> Import/Export
> Auto Maintain

pgrade

Information

Figure 3-77

3.8 Information

3.8.1 Version
The version interface is shown as in Figure 3-78.
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Here you can view system software version, WEB version, release date and etc. Please note the
following information is for reference only.

IP PTZ Dome

Camera Version
Network

PTZ

Master Version

2.210.0003.0. R A.1210, build : 2014-11-12

. WEB Version 321231776
Peripheral
ONVIF Version 241
Event
PTZ Version W1.03.20.RHNJEH
Storage
SIN PZB4BN290W0D0008

System
Information

> Log

Copynight 2014. All Rights Reserved

> Online User

Figure 3-78

3.8.2 Log
3.8.2.1 System Log
Here you can view system log. See Figure 3-79.

[ F e e le [ ve [ Payoack | sewp | mam | Logou ]

Camera Remote Log

Network
Ptz Start Time | 2013 - 07 - 21 || 17 : 25 : 34 End Time | 2013 - 07 - 22 || 17 : 25 : 34

: T =
Peripheral ype |All Search

Event s EooRkns

Storage
System
Information
> Version

> Online User

Detailed Information

[ 4u1h DicoTo [ (B

Figure 3-79

Please refer to the following sheet for log parameter information.

Parameter | Function

Type Log types include: system operation, configuration operation, data
operation, event operation, record operation, and user management,
log clear.
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Parameter | Function

Start time Set the start time of the requested log.

End time Set the end time of the requested log.

Search You can select log type from the drop down list and then click search
button to view the list.
You can click the stop button to terminate current search operation.

Detailed You can select one item to view the detailed information.

information

Clear You can click this button to delete all displayed log files.

Backup You can click this button to backup log files to current PC.

3.8.2.2 Remote Log
Here you can view remote log interface. See Figure 3-79.

A2 BRI [ ive | papack | sewp | mam | iogour ]

Camera Log Remote Log @

Network
I” Enable
Ptz
- IP Address
Peripheral

Port
Event

Storage

System
Information

> Version

> Online User

Figure 3-80

Please refer to the following sheet for log parameter information.

Parameter | Function

Enable Check the box here to enable remote log function.

IP address | Input server IP address.

Port Input server port. The value ranges from 1~65534.

3.8.3 Online User
The online user interface is shown as in Figure 3-81.
Here you can view online user name, group name, IP address and login time.
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IP PTZ Dome

Camera
Network
Ptz
Peripheral
Event
Storage
System
Information
> Version

> Log

Online User

IP Address
10.34.11.120
10.34.11.120

2013-07-22 16:36:14
2013-07-22 16:37:35

Figure 3-81
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4 Alarm

Click alarm function, you can see an interface is shown as in Figure 4-1.

Here you can set device alarm type and alarm sound setup. When the specified alarm occurred (you
have subscribed), system can record the corresponding alarm information on the right pane of the alarm
list.

il e [ rwpack [ sewp [ s ] ioson |
Alarm Type No. Time Alarm Type Alarm Channel
I Motion Detect I™ DiskFull
™ DiskError [~ Video Masking
I External Alarm
Operation
™ Prompt
Alarm Tone
™ Play Alarm Tone
Tonepath o—

Figure 4-1
Please refer to the following sheet for detailed information.
Type Parameter Function
Alarm Motion detect System alarms when motion detection alarm
type occurs,
Disk full System alarms when disk is full.
HDD System generates an alarm when HDD is
malfunction malfunction.
Camera System alarms when camera is viciously masking.
masking
External alarm Alarm input device sends out alarm.
Operation | Prompt System automatically pops up alarm dialogue box.
Alarm Audio When alarm occurs, system auto generates alarm
audio audio. The audio supports customized setup.
Path Here you can specify alarm sound file.
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5 Log out

Click log out button, system goes back to log in interface. See Figure 5-1.
You need to input user name and password to login again.

IP PTZ Dome

Figure 5-1

Note:

This manual is for reference only. Slight difference may be found in user interface.
All the designs and software here are subject to change without prior written notice.

All trademarks and registered trademarks are the properties of their respective owners.

If there is any uncertainty or controversy, please refer to the final explanation of us.
Please visit our website for more information.
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